
Copyright 2021 by Ken Hamady 

All rights reserved,  (540) 338-0194 
1 

The Expert’s Guide to Cross-Tabs 
Copyright © 2006-2021 by Ken Hamady 

525K East Market St. 

PMB 299 

Leesburg, VA 20176 

(540) 338-0194 

www.kenhamady.com (web site) 

ken@kenhamady.com (email address) 

 
All rights reserved.   The course is designed by Ken Hamady, an independent trainer and consultant.  Mr. Hamady 

has no affiliation with Business Objects or SAP.  Crystal Reports is a registered trademark of Business Objects, Inc.  

This material can be used and shared for free as long as it is not modified.  It cannot be sold.  

 

Notes on the Sample Reports: 
There are two kinds of sample reports included with this material.  The ones with the word 

Sample in the name are numbered to match the reports described in the exercises.  You can refer 

to them if you have trouble with one of the exercises, or you can compare your results with the 

corresponding sample report.  The other reports are taken from my “Experts Techniques” series.  

These are annotated reports that illustrate the several useful techniques described in the Tips and 

Tricks section of the material.  These have retained their original names from the series. 

 

All sample reports use an ODBC connection to the Xtreme Database. They will open in preview 

because they have saved data, but to refresh them you will need to set the location of the tables to 

a local ODBC connection to the Xtreme database.  This database installs with the Crystal sample 

reports and can also be downloaded from Crystal’s web site.  Most of the reports were created 

using version 8.5 so that as many users as possible could open them.  They should also work in 

versions 9, 10 and 11. 
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Cross-Tabs Overview: 
The table below is a simple example of a Cross-Tab: 
 

 Jones Smith Thomas Willis Total 

DC 2,500 2,400 2,200 1,800 8,900 

DE 1,500 1,250 0 2,000 4,750 

NJ 4,500 0 3,000 3,500 11,000 

NY 5,250 0 4,000 5,000 14,250 

PA 4,000 4,200 3,900 3,700 15,800 

Total 17,750 7,850 13,100 16,000 54,700 

 

A Cross-Tab is summary table that you add to a report to recap the data.  The most common 

Cross-Tab uses two fields to define the rows and columns of the table.  The Cross-Tab 

automatically adjusts the number of rows and columns in the table based on the number of 

different values found for each field.  It then puts a summary in each cell of the table.   

 

The example above is sales by state and by employee.  The Cross-Tab examined the records in 

the report and found 4 different employees and 5 different states.  It then created a row for each 

state and a column for each employee.  Last, it added up all of the sales for each state, subdivided 

each state by employee, and printed the subtotals in the corresponding cells.  If the report was 

run again, and the new results included one more employee, then another column would be 

added automatically.    

 

Note that v11 defaults to having the totals in the top row and in the left column while all older 

versions put the totals in the bottom row and in the right column by default.  All versions allow 

you to change to either style within the Cross-Tab Expert discussed below.  

 

General steps to create a Report-Level Cross-Tab: 

1) Switch to Design mode (this makes it easier to see the sections). 

2) Use the menu options Insert ���� Cross-Tab to open the Cross-Tab Expert.  

3) ** Version 11 only – Click in the upper left corner of the Report Header.  

4) ** Version 11 only – Right-click in the upper left cell of the Cross-Tab and select “Cross-

Tab Expert”. 

5) Select the field(s) to subtotal (like sales) and drag it into the “Summarize Fields” box.  If 

the field is numeric, the Cross-Tab will Sum by default.  If the field is a date or a string 

the Cross-Tab will count by default.  You can change the summary function by 

highlighting the total and clicking the “Change Summary” button.   

6) Select the row field from the field list and drag it into “Row Fields” box.   

7) Select the column field from the field list and drag it into “Column Fields” box.   

8) Click OK 

9) If you are NOT using v11,  you now click in the report header. 

 

Follow the exercise below to create your first Cross-Tab.  
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Exercise #1: 
Open Master.RPT and Save it as Lesson 1. 

Switch to Design mode. 

Use the menu options Insert > Cross-Tab  

(and if you are using v11 do steps 3 and 4 from the prior page). 

Drag the field Country into the box marked Rows.  

Drag the field ShipVia into the box marked Columns.  

Drag the field OrderID into the box marked Summarized Fields.  

Highlight OrderID inside the box and click the button marked Change Summary. 

Select the summary operation Count. 

 

Click on the tab marked Customize Style at the top of the window. 

Note the options at the bottom that say: 

 Row Totals on Top 

 Column Totals on Left 

Here is where you change the positions of the totals should you have a preference. 

 

Click OK  

 (and if you are NOT using v11 you can click in the Report Header). 

Switch to preview and note the Cross-Tab on the top of page 1.  

 

Save again as Lesson 1 
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Making changes to a Cross-Tab: 

Moving: 
If you need to move the Cross-Tab you can drag it by the empty cell in the upper left.  This cell 

is sometimes called the “handle”.  

 

Cell Width:  
You can adjust the width of the cells in design or preview.  When you click inside any cell, you 

will get sizing handles that allow you to change the width of that column.  Note that changing the 

width of one column may change other columns.   All columns doing the same summary will 

size together so that they remain the same width. 

 

Going back into the Cross-Tab Expert: 
If you need to make changes to the Cross-Tab settings you first select the Cross-Tab by clicking 

in the upper left (empty) corner.   Then, use the menu options Format ���� Cross-Tab Expert to 

reopen the Cross-Tab Expert.    You can also right-click in this same cell and select the Cross-

Tab Expert.  (In versions 8.x and prior the menu command is Format ���� Format Cross-Tab.) 

 

Once back in the Cross-Tab expert you can add or remove fields in any of the three boxes or 

change the summary operation for any summarized field.  You can also change the formatting 

options.  The Style tab has predefined styles, while the Customize Style tab allows you to change 

individual formatting attributes of the Cross-Tab.  These are discussed in more detail later.  

 

Exercise 2: 
Open Lesson 1 and save it as Lesson 2 

Switch to design mode. 

Use the ‘handle’ cell to drag the Cross-Tab to the upper left corner of the Report header. 

Preview and click on the country name “Switzerland”.  

Use the sizing handle to the right of the country name to make the column narrower.  

This should only affect this one column.  

Now click on the column heading FedEx.  

Use the sizing handle to make the column just a bit narrower.  

Note that all of the ShipVia columns get narrower together.  

 

Right click in the ‘handle’ corner and select the Cross-Tab Expert. 

Find the field Order Date and move that in to the Row box below Country 

Highlight OrderDate in the box and click Group Options. 

Change the setting from For Each Day to For Each Year.  

 

Find the field Order Amount and move that to the Summarized Fields box. 

Highlight Order Amount and click Change Summary, changing the operation to Average. 

Click on the “Customize Style” tab and highlight the row “Customer Country”. 

Change the Background Color (right side of window) to a lighter color like Aqua. 

Click OK and preview the report. 

Save this as Lesson 2.  
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Having Multiple Cross-Tabs in one report: 

You can have any number of Cross-Tabs in one report.   However you should be careful if you 

place one Cross-Tab directly below another.  Cross-Tabs have a tendency to grow and can grow 

right over objects that are below them in the same section.  One solution is to split the section 

into subsections so that each Cross-Tab has its own subsection.  

Which sections can hold a Cross-Tab? 

A Cross-Tab can be placed in four out of the seven report sections.  It will behave differently 

based on where it is placed.  A Cross-Tab placed in the Report Header or Report Footer will 

appear only once in the report, and will summarize all of the records in the report.  A Cross-Tab 

placed in a Group Header or Group Footer will appear multiple times, once for every group.  

Each group will have its own Cross-Tab that will summarize the records within that group.   

 

Exercise #3: 
Open Lesson 2 and save it as Lesson 3. 

Expand the Report header so that it is roughly twice as big. 

Use the menu options Insert > Cross-Tab  

  (if  using v11 place it beneath the original Cross-Tab and open the Cross-Tab expert). 

Drag the field Order Date into the box marked Columns.  

Highlight OrderDate in the box and click Group Options. 

Set the break level to be For Each Year.  

Drag the field OrderAmount into the box marked Summarized Fields.  

There will be no Row field in this Cross-Tab.  

Click OK (and if NOT using v11, place this Cross-Tab beneath the original Cross-Tab). 

Widen Column #1 and the Total column till you can see the words “Order Amount” in both cells. 

Preview and note how the first Cross-Tab overlaps the second.  

 

Switch back to design 

Right-click on the words “Report Header” in the gray margin on the left.  

Select Insert Section Below and you will see a new section called Report Header B. 

Make this new section about 1 inch deep and then drag the 2
nd

 Cross-Tab in this section. 

Right-click on the words “Report Header A” in the gray margin on the left.  

Select “Fit Section” to make the top section smaller again.  

Preview and note that the Cross-Tabs no longer overlap.  

 

Switch back to design mode. 

Locate the Group Header of the report and make that section 1 inch deep.  

Copy the 2
nd

 Cross-Tab and paste a second copy of it into the Group Header.  

Preview and page forward.  

Note that at the top of each group the customer has his own breakdown by year.  

Save the report again as Lesson 3. 
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Special Features of Cross-Tabs: 

Group Sorting (TopN) within Cross-Tabs: 

You can tell the Cross-Tab that you only want to see the highest or lowest rows, like the Top 10 

rows, by using the Group Sort feature.   You first click in the upper left corner of the Cross-Tab, 

and then you use the menu options Report ���� Group Sort Expert.  The window you see may 

not make it clear, but you are now setting the Group Sort properties of the Cross-Tab, not the 

report.  Unfortunately, you can only use this feature with the rows of the Cross-Tab, not the 

columns.  Also note that if you use this feature in conjunction with the next feature (specified 

order) you must put the TopN settings in first.   Using specified order on either rows or columns 

locks the Group Sort menu option.  

Specified Order Grouping: 

Both the row and column fields have a “Group Options” button in the Cross-Tab Expert.   These 

allow you to set the sort order to Ascending, Descending or In Specified Order.   Specified Order 

in a Cross-Tab works just like it does in groups; allowing you to specify the order of individual 

rows or columns.  This way you can put your columns into a non-alphabetical order.  You can 

even lump smaller groups into larger ones.   

Date Groupings: 

Whenever you use a date or date-time field as a row or column field you get some additional 

settings in Group Options.   These allow you to decide if each column should represent a day, 

week, month, year, etc.   Exercise #3 used this feature to do subtotals by Year.  

 

Exercise #4: 
Open Lesson 1 and save it as Lesson 4. 

Switch to design mode and click anywhere other than on the Cross-Tab object.  

Use the menu options Report > Group Sort Expert (TopN in v8 and older).  

Notice that the group field listed is Customer Name – the group of the main report.  

Now click in the handle cell of the Cross-Tab and use the same menu options. 

Notice that the group field listed is now Country - the row field of the Cross-Tab.  

Change the first setting to TopN, based on the Count, where N = 5 and include others.  

Click OK and preview.  Only the 5 largest countries appear in the Cross-Tab.  

 

Right click in the handle cell and select the Cross-Tab Expert (Format Cross-Tab in v8.x). 

Highlight the column field (Ship Via) and select Group Options. 

Change ascending order to specified order. 

Click the drop down under Named Group and select FedEx, then UPS, then Loomis. 

Click on the Others tab and select put all others together, with the name “Others”.  

Click OK, then click OK.  Note that only 4 columns appear in the Cross-Tab.  

 

Click in the handle corner and then go into the Report menu.  

Note that you can’t select the Group Sort (TopN) feature for the Cross-Tab, anymore.  

To change or remove your Cross-Tab’s TopN settings you would first have to change the 

Specified Order back to ascending or descending order. 

 

Save the report again as Lesson 4. 
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Pivoting a Cross-Tab: 

If you would like to see how the Cross-Tab would look with the row and column fields reversed 

you can pivot the Cross-Tab.  This changes all of the column fields into row fields and the row 

fields into column fields.   To pivot a Cross-Tab you right-click in the handle corner and select 

pivot.  The Cross-Tab will change immediately.    

Horizontal Pages: 

Crystal can only generate a page that is as wide as your chosen printer.  This means that if you 

choose to print on 8.5 x 11 paper in portrait mode you will only get about 7.5 to 8 inches of 

horizontal printable area.  To make your report wider you need to change paper size or switch to 

landscape.   This is always true, even on reports that are never printed (like Excel exports).  This 

is because Crystal uses your chosen printer driver to format all pages, even those not printed.  

 

The challenge with Cross-Tabs is that they get wider and narrower based on the number of 

values found for your column field.  If you have more columns in your Cross-Tab than you can 

print on your page, Crystal will split the Cross-Tab and generate virtual pages off to the right.  

These are called “horizontal pages”.  Any columns that don’t fit on the primary page will print 

on the new horizontal page or pages to the right.   In terms of page numbering any pages to the 

right of page 1 are also considered page 1.  If a wide Cross-Tab is printed to paper, the horizontal 

pages will print immediately after their primary page.   You could say it prints across then down.  

 

As you saw in Exercise #3, objects placed just below a Cross-Tab in design mode will typically 

be covered by the Cross-Tab when it grows down.  In a similar way, objects placed to the right 

of a Cross-Tab in design mode will typically be covered by the Cross-Tab when it grows to the 

right.   

 

Starting with version 9 you have the ability to specify that a section containing a Cross-Tab 

should use Relative Positions which affects the other objects in that section.  With Relative 

Positions, the other objects’ horizontal position (in preview) will be based on its position relative 

to the right edge of the Cross-Tab (in design).   The objects will shift as the Cross-Tab gets 

wider.  Note that setting this property for a section prevents you from dragging objects in that 

section while in preview mode.  

 

Other than using Relative Positions, the only other way to get a field to print on a horizontal page 

is to incorporated the object into the Cross-Tab itself.   For instance a field can be pasted  into the 

text boxes that label the totals columns.  See Expert Techniques 1, 2 and 53. 

 

I find it is best to avoid horizontal pages whenever possible by using landscape mode or legal 

size paper.  If you don’t need to print the report on paper (i.e. if you only need to view or export) 

you can use the printer driver from a really wide printer, like a plotter printer.  A plotter driver 

can generate a wide “page” on the screen, even though you are not physically connected to a 

plotter printer.  All you need to do is install and configure the printer driver.  You can then view 

and export without having the actual printer.   Note that if you move this report to another PC it 

must also have that printer driver installed or the design area will narrow to the width of the page 

on that PC’s default printer.  
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Exercise #5: 
Open Lesson 1 and save it as Lesson 5. 

Preview and note that the rows are Countries.  

Right click in the handle corner and select Pivot Cross-Tab.  

Note that now the Countries are columns.  

Also note that the Cross-Tab has generated a horizontal page to the right.  

 

Go into File > Printer Setup (use File > Page Setup in v11)  

Set the report to Landscape mode on Legal size paper.  

The Cross-Tab should now be on one page (or close to one page).  

Change it back to Portrait Mode on Letter size paper and the horizontal page is back.  

 

Switch to design mode and expand the Report Header by ¼ inch. 

Move the Cross-Tab down so that there is empty space above it.  

Move the page number field to just above the Cross-Tab, over the Total column.  

Preview and note that the page number doesn’t move to the right with the total column.  

Also note that it doesn’t appear anywhere on the horizontal page.  

Switch back to design mode and widen the Total column of the Cross-Tab to 1.5 inches. 

Right-click on the page number object and select Copy. 

Right-click on the word Total and select Edit Text. 

Delete the word “Total” and type the word “Page” instead. 

Paste the page number right after the word “Page”.  

Click outside the box to lock in your changes.  

Narrow the Total Column of the Cross-Tab to be ¾ inch.  

Preview and note that the total column of the Cross-Tab has the page number at the top. 

 

(The following features are only available in versions 9 and later) 

Open up the section expert and highlight the Report Header section name on the left.  

Put a check mark in the option “Relative Positions” and click OK.  

Preview and note that the original page number now prints above the Totals column. 

Switch back to design mode and put the Page Number field to the right of the Cross-Tab. 

Preview and note that the page number stays to the right of the Cross-Tab as it grows.  

Save the report again as Lesson 5. 
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Formulas and Cross-Tabs: 

Using Formula Fields in Cross-Tabs: 

You can use most formula fields as row fields, column fields or summarized fields in a Cross-

Tab.  Any formula that can be summarized in a normal subtotal or grand total can also be used in 

a Cross-Tab.  The few formulas that can’t be summarized typically have summary fields as part 

of the formula or use certain functions (Previous, Next, WhilePrintingRecords, etc) or contain 

shared variables.   

 

Customizing the Group Name: 

The row field of the Cross-Tab doesn’t have to be used as the label of the row.  You can use one 

field to group the row, but a different field to be the label, just like you can with Groups in the 

report.   The same is true for columns.   For instance, if you want a row for each customer you 

could use the Customer Number as the row field but the then use the Customer Name as the row 

label.   

 

To select a different field as your label you go into the Group Options for that field and select 

Customize Group Name Field.  You can select any database field from the drop down list, or you 

can use the  “X-2” button to  write a formula that calculates your Group Name.  
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Exercise #6: 
Open Lesson 1 and save it as Lesson 6. 

Create 3 new formulas fields: 

 Day Of Week:  DayOfWeek ({Orders.Order Date}) 

 Fiscal Year: Year ({Orders.Order Date} + 92) 

 FedEx Orders: if {Orders.Ship Via} = "FedEx"  then 1 else 0 

Right-Click in the handle cell and select Cross-Tab expert (or Format Cross-Tab in v8.x).  

Use Day of Week as the Row field and Fiscal Year as the Column Field. 

Use FedEx Orders as the Summarized field, using the Sum operation.  

Click OK and preview to see a Cross-Tab with 2 rows and 7 columns.  

 

Note that the columns are numbers for each day of the week.  

Right-Click in the handle cell and select Cross-Tab expert (or Format Cross-Tab in v8.x).  

Highlight Day of Week (the Row field) and click Group Options. 

In the bottom of the window check off “Customize Group Name Field” 

Below that select the radio button “Use a formula…” and click the “X-2” button.  

Enter the following formula:   

WeekDayName({@Day Of Week},true) 

Save and close the formula editor, the click OK and click OK again.  

Note that your column headings are the abbreviated days of the week.  

Also note that they still appear in chronological order.  

 

Note that the years that label each row have commas and decimal places.   

Right-click one either year value and select Format Field.  

Choose the first value in the list [-1123] which has no commas or decimals.  

Click OK.  Note that there are no more commas or decimal points in the years.  

 

Note that every total cell has 2 decimal places.  

Click in the grand total cell and click the “reduce decimals” button on the toolbar twice.   Notice 

that only that once cell loses its decimal places.  

Click any other cell in the total row and again use “reduce decimals” twice.   

Note that only cells in that row change. 

Click any other cell in the total column and again use “reduce decimals” twice.   

Note that only cells in that column change. 

Click any other interior cell and again use “reduce decimals” twice.   

Note that all of the other cells reduce decimals.  

Save the report again as Lesson 6. 
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Conditional Formatting Formulas within Cross-Tabs: 

When setting the formatting properties of most report objects, you will see some “X-2” buttons 

next to the properties.  These allow you to control the formatting properties based on values in 

the data.  These “X-2” buttons also appear when setting the formatting properties for the cells of 

a Cross-Tab.  There are even some special formatting functions that apply only to Cross-Tab 

cells.  These allow you to reference the value of the current cell or the corresponding row and 

column values for the current cell value.   These can be used to control just about every 

formatting property of the cell. 

 

Take the Cross-Tab used in first lesson.  You could set the background color of the cell to 

change when any or all of these are true: 

1) The cell has a value that meets a criteria, like being over 100. 

2) The cell is in a specific column, like the FedEx column. 

3) The cell is in a specific row, like the USA row. 

 

To see the special functions you can right click in any summary cell of the Cross-Tab and go into 

Format > Field.  Open any one of the “X-2” formulas and look at the top of the function list.   

You should see a category named Formatting Functions with the following 4 options:   

 

CurrentFieldValue – When used in a calculation this represents the summary value of the 

current cell.  This allows you to highlight any instance of this cell that is too high or low. Use 

this to accomplish item 1 mentioned above.  

 

DefaultAttribute - This tells the formula when to use the default attribute value (i.e. the default 

color for this attribute).  It is often used as the ELSE value in IF-THEN-ELSE attribute formulas, 

like for font colors or background colors.   

 

GridRowColumnValue ()  -   This allows you to specify the field name of a row field or a 

column field in the Cross-Tab.   You can then use this to format specific rows or columns 

differently.  Use this function to accomplish items 2 and 3 mentioned above.  

 

Row or Column Names - These are used to automatically fill in the parentheses of the 

GridRowColumnValue() function.   

 

The exercise below shows examples of all 4 of the above functions.   

 

Note - when you conditionally change the background color of a cell, the color doesn’t include 

the ‘cell margins’ or the space between the numbers and the Cross-Tab lines.  There is no way to 

conditionally control the color of the margin space in each cell.  You can, however, turn off the 

cell margins which makes all of the cells smaller.   This is done on the Customize Style tab of the 

Cross-Tab Expert, which is discussed in a later lesson.  
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Exercise #7: 
Open Lesson 1 and save it as Lesson 7. 

Preview and locate the FedEx column.  

Right click on any number in the column that is next to a country (not the total of the column). 

Select Format Field and then click on the Border tab.  

Find the Background Color property and click the X-2 button to it’s right.  

(It should say Back_Color at the top of the window. ) 

Go to the top of the function list and open the  category marked Formatting Functions. 

Use the functions to build the formula below. 

Note that "Customer.Country" can be put automatically into the parentheses by using: 

 “Row or Column Names”  

 

if CurrentFieldValue > 4 

and GridRowColumnValue ("Customer.Country") <> "USA" 

and GridRowColumnValue ("Customer.Country") <> "Canada" 

then crAqua 

else DefaultAttribute 

 

This says that if any cell is over 4 and isn’t in the USA or Canada rows then give it an Aqua 

background color, otherwise give it the default background color which is transparent.  

 

Save and close the formula and click OK to close the Cross-Tab Expert.  

Notice that a few cells have a background color (Those over 4 and not USA/Canada).  

Save again as Lesson 7. 
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Customizing the Style: 
Crystal gives you quite a bit of control over how the Cross-Tab is presented including where and 

how the totals are printed, which lines of the Cross-Tab (if any) should be drawn and what colors 

the lines and cells should be.    

 

The second tab of the Cross-Tab expert (the one called Style)  has several interesting examples 

that show you what certain combinations of properties will produce.  Then the third tab allows 

you to change each individual attribute.  So, if one of the predefined styles is close to what you 

want you can use the second tab to select that as your starting point.  You can then use the third 

tab to make adjustments to individual properties.   The exercise below shows several examples of 

individual properties that you can change.  

 

One use for these properties is when you want the Cross-Tab to simply generate a list of items 

that occur in the report.  You can eliminate most of the things that make a Cross-Tab look like a 

Cross-Tab so that all that remains is the list of items.  For this you would eliminate all of the 

lines and suppress all of the summary fields.  See the last part of this exercises for the steps. 

 

Exercise #8: 
Open Lesson 2 and save it as Lesson 8. 

Right-Click in the handle cell and select Cross-Tab expert (or Format Cross-Tab in v8.x).  

Remove Ship Via from the Columns box.  

Drag Order Date from the Rows box to the Columns Box. 

Click “Group Options” to confirm that Order Date is set to “for each year”. 

Click on the Style tab and select the Sepia style.  

Click OK (and then Yes in the message box). 

Preview the report to see what Sepia style looks like.  

 

Right-Click in the handle cell and select Cross-Tab expert (or Format Cross-Tab in v8.x).  

Click on the Customize Style tab. 

Highlight the words Grand Total in the Rows box. 

Go to the right side of the window and select a gray or silver background color. 

Highlight the words Grand Total in the Columns box. 

Again, go to the right side of the window and select a gray or silver background color. 

 

Then in the lower left click the button marked Format Grid Lines. 

Slide down the list of lines until you find “Column Labels Bottom Border”. 

Highlight this and check off the Draw property (which makes this line appear) 

Change the line style from Single to Dotted. 

Click OK and then click OK to exit the Cross-Tab Expert.  

Preview and note the changes in the Cross-Tab.  

Click Undo, then Redo to compare the before and after look of the Cross-Tab.  

 

(The following features are only available in versions 9 and later) 

Right-Click in the handle cell and select Cross-Tab expert.  

Click on the Customize Style tab. 

On the right side find the check box labeled “Show Labels” and check it.  

Just to the left of this property change Vertical to Horizontal 

Click OK and then click OK to exit the Cross-Tab Expert.  

Preview and note the changes in the Cross-Tab.  
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Switch back to design mode and use the menu commands Insert > Cross-Tab 

Put the field Ship Via in both the Rows box and the Summarized Fields Box. 

Click on the tab marked Customize Style. 

In the lower left, take out the check mark for Show Cell Margins.  

Below that, click the button named Format Grid Lines. 

Take out the check mark that says Show Grid Lines.  

Click OK and then click OK.  

Preview and note that there are no lines in this Cross-Tab. 

Also note that there is very little space between the rows of the Cross-Tab.  

 

Now you can suppress everything but the list of shipping  values: 

Hold down your Control key and click on the word Total at the bottom of the Cross-Tab. 

Then click on the grand total number just to the right of this word.  

Then click on the number just above the grand total.  

Then click on the word Total at the top of this column.  

Now you can release the Control key. 

Right-click on the word Total and select Format Objects.  

Locate the Suppress property on the Common tab and check it off.  

Click OK and your Cross-Tab is now just a list of shipping values.  

 

Save this report again as Lesson 8. 



Copyright 2021 by Ken Hamady 

All rights reserved,  (540) 338-0194 
16 

Charts that use Cross-Tabs: 
If you have a Cross-Tab in your report, you can use the rows or columns to create bars in a bar 

chart or slices in a pie chart.  The cells in the Cross-Tab become the subtotals which tell the chart 

how big the bars should be or how wide the slices should be.  

 

Exercise #9: 
Open Lesson 6 and save it as Lesson 9. 

Switch to design mode and add a new section to the Report Header: 

 Right click on the words Report Header.  

 Select the option Insert Section Below.   

Move the Cross-Tab so that it is in Report Header B.  

Use the menu options “Insert Chart” to open the Chart Expert.  

 (In v11, click in Report Header A and then right-click on the background of the chart and select 

the Chart Expert. ) 

On the Type tab select a stacked bar chart (middle option).  

Click on the Data tab and then select the Cross-Tab option on the left side (3
rd

 option).  

Set the On Change Of to be Day of Week 

Set the Subdivided By to be Fiscal Year 

Set the Show to be Sum of FedEx Orders. 

In versions 9 and 10, click in Report Header A to place the chart in the section.  

Preview and note the 7 bars each divided into 2 fiscal years.  

 

Note that the legend of the chart has commas and decimal places for the fiscal year.  

Open the field explorer and right-click on the formula Fiscal Year.  

Change the formula to be: 

  Totext (Year ({Orders.Order Date} + 92) , '0000') 

Save and close the formula and preview the report.  

Note that as a text value it doesn’t show commas or decimals.  

 

Right click on the Chart and go into the Chart Expert.  

Go to the TEXT tab. 

Remove the TITLE check mark and make the title say FedEx Orders. 

Remove the Group Title check mark and delete the text in that box 

Remove the Data Title check mark and make the title say FedEx Orders. 

Click OK to preview the report.  

 

Save this report again as Lesson 9. 
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How Other Report Features affect the Cross-Tabs: 
Sometimes changing other features of the report can affect the Cross-Tab.  For instance changing 

the criteria in the select expert will usually affect the numbers in the Cross-Tab, but not always.   

Here are some guidelines: 

Select Expert: 

Changing the rules in the select expert will only affect the Cross-Tab if the rule being changed is 

based on a database field or a formula field.  When the rule being changed is based on a subtotal 

then that change will NOT affect the numbers in your Cross-Tab.  This because the first change 

modifies the record selection formula which is applied to the report before the Cross-Tab does its 

calculations.  It actually changes the number of records returned from the database.   But, rules in 

the select expert that are based on subtotals affect only the Group Selection Formula which is 

applied to the data after the Cross-Tab has already done its calculations.  

Sorting and Grouping: 

Changing the sorting or grouping of the main report will not change the values in the Cross-Tab 

because the Cross-Tab does its own independent sorting and grouping.  However there is one 

exception.  If you put you put one of the report’s groups into specified order and then tell it to 

exclude the “others”, then these other records are excluded from the entire report and therefore 

are not included in the Cross-Tab.   

Group Sorting (TopN): 

Doing a TopN of the main report groups will never affect your Cross-Tabs.  This is true even if 

you tell the TopN feature not to include the “Others”.   TopN is based on subtotals (not fields 

like the Specified Order) so these “Others” are determined after the Cross-Tab has done its 

calculations.  

 

 

Exercise #10: 
Open Lesson 1 and save it as Lesson 10. 

Note that the Cross-Tab Grand Total is 801 and there are roughly 21 pages in the report.  

 

(changing record selection) 
Open the Select Expert and change the existing criteria to be between 2200 and 2800.  

Click OK and use saved data. 

Notice that the report gets shorter and the Cross-Tab has a lower grand total.  

Click one Undo and use saved data again.  

Note that the report goes back to the original length and the total goes back to 801. 

 

(changing group selection) 
Open the Select Expert and click the tab marked New 

Highlight the Group#1 Customer Name - Sum of Order Amount 

Click OK, and change the rule to say:  Greater then / 25000 

Click OK and notice that the report drops to around 8 pages. 

Notice that the Cross-Tab totals (like the grand totals of the report) don’t change. 

Open the Select Expert delete the criteria based on the subtotal. 

Click OK and notice that the report goes back to 21 pages 
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(changing the sort and group) 
Locate the A-Z (sorting) button on the tool bar and click it.  

Move the Order Date field from left to right. 

Click OK and note that the details are now in chronological order.  

However the Cross-Tab totals do not change.  

 

Go into the Report menu and open the Group Expert (Change Group Expert in v8.x). 

Highlight the group Customer Name and click Options.  

Change the group field from Customer Name to Country.  

Click OK to exist the Group Expert.  

Note that the groups are now based on Countries. 

Also note that the Cross-Tab hasn’t changed.  

 

Go into the Report menu and open the Group Expert (Change Group Expert in v8.x). 

Highlight the group Country and click Options.  

Change Ascending Order to Specified Order.  

Drop down the selection list under Named Group and select USA.  

Drop down the selection list again and select Canada.  

Drop down the selection list again and select England.  

Click on the tab marked Others and select the middle option, “Put all others together…”. 

Click OK and notice that the report only has 4 groups, but the Cross-Tab isn’t changed.  

 

Go into the Report menu and open the Group Expert (Change Group Expert in v8.x). 

Highlight the group Country and click Options.  

Click on the tab marked Others and select the top option, “Discard all others”. 

Click OK and notice that the report only has 3 groups, and the Cross-Tab has lower totals.  

 

Go into the Report menu and open the Group Expert (Change Group Expert in v8.x). 

Highlight the group Country and click Options.  

Change the Specified Order back to Ascending Order.  

Click OK and note that the Cross-Tab totals go back to their original values.  

 

(Changing the GroupSort or TopN) 
Go into the Report menu and open the Group Sort Expert (TopN Sort Group in v8.x). 

Set the report to be a TopN, Based on the Sum of Order Amount, Where N is 10.  

Put a check mark into Include Others if it isn’t already there and click OK.  

Note that the countries of the main report are ranked but that the Cross-Tab isn’t affected.  

 

Go into the Report menu and open the Group Sort Expert (TopN Sort Group in v8.x). 

Take out the check mark in Include Others and click OK.  

Note that the report gets shorter but the Cross-Tab doesn’t change.  

 

Save this report again as Lesson 10. 
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 Manual Cross-Tabs: 
There are two limitations of Cross-Tabs that people frequently encounter.  

   1) There is no way to add a calculated cell to a Cross-Tab, using other cell values.   

   2) There is no way to drill-down on a Cross-Tab row or cell.  

 

These can be done, in a limited way, using a ‘manual’ Cross-Tab, which is a summary report 

constructed to look like a Cross-Tab.  The rows of a manual Cross-Tab are the group footers of 

the report.   The group header and details are hidden.   The columns of a manual Cross-Tab are 

made by writing If-Then-Else formulas and creating subtotals of those formulas.  The formulas 

look something like this: 
 

If  {Orders.Ship Via} = "FedEx" 
then {Orders.Order Amount}  else 0 
 

This column will print only the FedEx amounts, so a subtotal of this formula will be a FedEx 

subtotal.  If you hide the details, you will see a column of subtotals that look like a Cross-Tab 

column.  You have to create a separate formula and corresponding subtotal for each column in 

your manual Cross-Tab.  The advantage is that you can use these subtotals in formulas on the 

Group Footer.  You can also drill-down on them to the details.   The disadvantage is that the 

number of the columns is now hard-coded.  New columns will not automatically appear like they 

do in a true Cross-Tab.   Here are the steps to create a manual Cross-Tab: 

 

Exercise #11: 
Open Lesson 4 and save it as Lesson 11. 

Switch to Design mode.  

Delete the Group Name from the Group Header. 

Move all of the column headings from the Page header to the Group Header. 

Delete the Sum of Amounts from the Group Footer (but leave the Count of Orders).  

Hide the Details and the Group Header.  

 

Use the menu options Report ���� Group Expert and click Options.  

Drop down the field list and select the field Country as the Group Field.  

Click OK and Click OK again to close the Group Expert.  

 

Use the menu options Report ���� Group Sort Expert to make this a Top N Report.  

Select TopN  and then set the “based on” to be Count of Orders 

Set the N to be 5 and check to include Others.  

Click OK to exit the Group Sort Expert.  

 

Right click in the left margin on the word Details and select Insert Section Below. 

This will create a Details B section.    

Right Click on the words Details B and select Suppress. 

 

Write a new formula called FedEx that says: 
If  {Orders.Ship Via} = "FedEx" 
then 1  
else 0 

 

Write a second formula called UPS using the same formula but changing FedEx to UPS. 

Write a third formula called Loomis using the same formula but changing to Loomis. 
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Write a fourth formula called Others that says: 
If  {Orders.Ship Via} = ["FedEx" ,”UPS” , “Loomis” ] 
then 0  
else 1 

 

Note that the THEN is a zero in this formula. 

 

Place the FedEx formulas onto Details B around the 3 inch mark.  

Place the UPS formulas onto Details B around the 4 inch mark.  

Place the Loomis formulas onto Details B around the 5 inch mark.  

Place the Others formulas onto Details B around the 6 inch mark.  

Use Insert - Summary  to add a subtotal and a grand total for each of these 4 formulas.  

 

What you should see when you preview is a manual Cross-Tab.  

Double click on any subtotal and you will drill down to the details that make up that row.  

 

(Note that the drill-down shows the details for the entire row of the manual Cross-Tab, not the 

details for the specific subtotal column that you clicked on.) 

 

Create a new formula called Others Share 

Locate the subtotals in the field list by looking for the sigma symbol in the field list.  

Double click the appropriate Group #1 sigma’s to build the following formula: 

 
if Count ({Orders.Order ID}, {Customer.Country}) = 0  
then 0 else  
Sum ({@Others}, {Customer.Country}) %  
Count ({Orders.Order ID}, {Customer.Country}) 

 

Place this formula onto the group footer to the far right around the 7.5 inch mark.  

Click the % symbol on the tool bar to make this look like a percentage.  

Preview.  

You can now add formulas that refers to your Cross-Tab ‘cells’.  

 

Save this report again as Lesson 11. 
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Tips and Tricks: 

1. Page numbers for Cross-Tabs placed in the Report Header  

 (01 Cross Tab Page Numbers.rpt) 
One of the most common places to locate a Cross-Tab is in the Report Header.  However, if the 

Cross-Tab goes on for multiple pages, you won’t see page numbers at the bottoms of the pages.  

This is because Page Headers and Page Footers don’t start printing until the Report Header is 

complete.   

 

The solution is to create a "Blank" group, which is a group that contains all of the records in the 

report.   Sometimes you will have a field in the database that all records have in common, and 

you can use that for you “Blank” group.    

 

If you can’t find a field to use, you can create a formula field that gives the same value for every 

record and use that formula as you group field.  CR will let you group on a constant formula like 

“x”, but only if you make this into a ‘recurring’ field, or a column of data.  You do this by 

starting the formula with WhileReadingRecords.  Otherwise it won’t be eligible as a group field.  

The formula below would work: 

 

WhileReadingRecords;  "" 

 

So the steps are: 

1) Write the formula above.  

2) Insert a new group using the formula. 

3) Make this group the primary group for the report (above any existing groups). 

4) Suppress the Group Footer for this new group. 

5) Move your Cross-Tab from the Report Header to the new Group Header. 

6) Suppress the Report Header.   

 

Because this new group includes all records, the Cross-Tab will still include all of the records in 

the report.  However, because CR sees this as a group, it will print this section between the Page 

Header and Page Footer.  

 

Notes: 
You may not want all of the Page Header, at least the part with column headings, to print on the 

Cross-Tab pages.   To prevent this you can suppress part or all of the Page Header with the 

condition: 

 OnFirstRecord 

 

If there is no page break after the Cross-Tab, there may be a few rows of the report below the last 

line of the Cross-Tab.  This section of the report will not have column headings because of the 

suppression we just entered.  The solution is to split the Group Header that contains the Cross-

Tab in to GH1a and GH1b.  Leave the Cross-Tab in GH1A and put a second set of column 

headings into GH1b.   These will appear just once in the report, just below the Cross-Tab.  
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2. Titles on Cross-tabs that spills onto horizontal pages 

 (02 Cross Tab Headings.rpt) 
If a cross-tab gets too wide, it will generate a ‘horizontal’ page to the right of the original.  When 

you print the report to paper, these horizontal pages print as separate pieces of pager.  However, 

the page header objects do not automatically repeat on these pages.  So, any titles that you have 

in your page header will be missing on these horizontal pages.  You have two options. 

 

1) If you are using a later version of Crystal Reports (v10 or later) you can format fields outside 

the cross-tab to repeat on each horizontal page.  Right-click on the field, select “Format Field” 

and go to the common tab.  You should see a property called “Repeat on Horizontal Pages”.  

Checking this property will cause the object to print again automatically for every horizontal 

page.  

 

2) In all versions you can put titles into the cross-tab in such a way that they print at the top of 

each horizontal page.   You do this by writing a blank group formula similar to the one in the 

previous example, and using it as a column field.   Only this time you make it a text string.  You 

can even incorporate report parameter fields into this title and have it print on multiple lines.   An 

example formula might be: 

 

WhileReadingRecords; 

"Sales by Region and Shipping Mode" + Chr(13) +  

"Orders From: " +  ToText ( Minimum ( {?Order Range} ) , 0 , "" )  +  

" To: "  +  ToText ( Maximum ( {?Order Range} ) , 0 , "" )   

 

The key is that the formula has to be a WhileReadingRecords formula, like the one above for it 

to be eligible to use as a cross-tab column. You make this field the first “Column” field in the 

cross-tab, and use the “suppress subtotal” property so that it doesn’t generate duplicate grand 

totals.     

 

Note: 
If you add this to an existing cross-tab you may notice that the heading wraps before it is 

supposed to, and will probably truncate some text.  One solution is to widen the (suppressed) 

subtotal column that was added for the new formula.  Widen it until the Title displays correctly.  

If this doesn’t work you can delete ALL of the column fields temporarily; then run the cross-tab; 

and then put the column fields back in starting with the new formula first.  This should cause the 

size to adjust correctly.  
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3. Labels for each summary field in a single Cross-Tab row: 

 (02 Cross Tab Headings.rpt) 
If your Cross-Tab has multiple summary (total) fields, Crystal will put one summary field below 

the other in each cell.   However, there is no visible indication of the summary operation being 

used in each cell.   One limited option is to double click on the Cross-Tab text objects (the ones 

that say “Total”) and put in more descriptive text.  This helps, but this does not appear on each 

line.  If you have many different summaries being calculated you might want to have the 

summary operation or some other description appear for each row of the Cross-Tab.  To do this 

you have to write a formula to use as your Row Label field.   An example would be: 

 

 {Orders.Ship Via} + "  - # Orders" +  

CHR (13)  + "Total Dollars"  + 

CHR (13)  + "Average Order" 

 

This will generate a 3-line formula and you can put your own text descriptions on each line.  The 

first line should contain the original row field.  When you place this into the Cross-Tab, make 

sure that the first column is wide enough for the longest line of text that it has to print.  

Otherwise the formula will wrap one or two extra times, throwing off the alignment.  Also, make 

sure that the font and text style that you use for the first column matches the other columns, or 

else the total rows won’t align with the labels.  
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4. Using Cross-Tab cells to create running totals: 

 (04 Cross Tab Running Totals.rpt) 
This technique is for Advanced users who are comfortable with variables.  If you are not 

familiar with Crystal Reports variables you might want to get my Expert’s Guide to Formulas, 

which has a more complete explanation of how variables work, and how to use them.    

 

There is one thing that is unusual about variables in Crystal.  You determine how often a variable 

will be fired by the physical location of the formula that fires the variable.  Normally this 

physical location is one of the 7 sections of the report.   However, you can also fire variables 

from within conditional formatting formulas.   This includes the conditional formatting 

properties of individual cells in a Cross-Tab.    

 

So what does this allow you to do?    Here are some examples: 

 

Create a running total in a Cross-Tab and display the result at the top of the report.  

Calculate values in the Cross-Tab and use them outside the Cross-Tab.  

Capture subtotals of groups that don’t exist in the report, for example:  

1) Find the Top 3 products in a report grouped by Customer, and then highlight those 

products throughout the main report.  

2) Calculate an average, minimum and maximum price per item, even when the report is  

not grouped by item, and then compare the rest of the report prices to the average.  

Create running totals using groups of records that don’t exist in the report.  

Create Totals of Totals that don’t exist in the report (Distinct Count within Cross-Tab Groups). 

Show the Total of the Top10, without others, at the beginning of the report.  

Add up the Maximums or Averages of each group, and display the total at the top of the report. 

 

Here is one simple example.  You use TopN to find the top 5 customers and you exclude the 

others.   Because of the way Crystal does totals, the Grand total of your report still includes the 

“others”.  So you put in a running total field to get an accurate total without the “others”.  This 

works fine, but this running total can only be used at the end of the report.  If you move it to the 

first page you will only see the value of the first record.  However, you can use an invisible 

Cross-Tab to calculate this number and make it available at the beginning of the report.  

 



Copyright 2021 by Ken Hamady 

All rights reserved,  (540) 338-0194 
25 

Here are the steps: 
1) Add a new Cross-Tab, in the Report Header using the Group field in your report as the row 

field.    

2) Make the Cross-Tab a TopN Cross-Tab by selecting the Cross-Tab in the upper left corner and 

going to the menu options Report – TopN (or Report - Group Sort Expert in v9).  This will allow 

you to do the same TopN in the Cross-Tab that you are doing in the report.   Notice that even in 

the Cross-Tab, the total includes the others.  

3) Right-click on any customer total in the Cross-Tab, and select Format-Field. 

4) Find the “Keep Together” conditional formula button on the common tab, and open the 

formula.   5) Add the following formula: 

WhilePrintingRecords ;  

CurrencyVar Top; 

Top := Top + CurrentFieldValue; 

True 

 

This is your standard running total formula.  The Boolean on the end is just there to satisfy the 

condition of this formatting property.  We could have used just about any formatting property to 

do this.  This formula will fire each time there is a customer total, and it will take the current 

cell’s contents and add that to the variable, accumulating all 5 of the customer totals.  

 

6) Add a new formula field to the report to display the result of the accumulation.  This formula 

should go in a section below the Cross-Tab, so you will probably want to split your Report 

Header into at least 2 pieces, and put this formula in the second one.   You want to make sure 

that this formula is evaluated after the Cross-Tab.  

 

WhilePrintingRecords ;  

CurrencyVar Top; 

 

7) Make the Cross-Tab invisible.  The amount of work to make the Cross-Tab invisible might 

surprise you.  If you simply suppress the Cross-Tab, or the section holding the Cross-Tab, it 

won't run at all.  That means that none of your formatting formulas will fire.  Making a Cross-

Tab invisible is much like making a subreport invisible.   First you suppress all of the elements 

of the Cross-Tab and then you underlay the section that holds the Cross-Tab. 

 

The elements of the Cross-Tab include the cells and the lines.  You suppress the cells by right 

clicking in each cell and checking the suppress property.   If you try to suppress all of the cells 

together as group, do NOT include the cell with your running total formula in the group.  You 

must do this one cell separately or you will either erase the running total formula or transfer the 

formula to all of the other cells in the group.  Then suppress the Cross-Tab lines.  Go in to the 

Cross-Tab expert and take the check marks off of the Grid and the Margins properties.   

 

Now that the Cross-Tab is invisible, you don’t want it to take up space.  Use the menu options 

Format – Section (Report – Section Expert in v9) and highlight the section that contains the 

Cross-Tab.  Check off the property marked “Underlay following sections”.  Now the Cross-Tab 

is invisible and doesn’t take up any space on the report.  But, it is still calculating a running total 

variable that can be used at the beginning of the report and can be used for other calculations 

throughout the report.  
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Using other Cross-Tab cells: 
If you want to use other cells for this technique, you might want to know the order in which the 

cells of a Cross-Tab are evaluated.  After a bit of experimenting I found the following order, 

which is somewhat surprising: 

 

First all of the cells with totals: 

1) The first (left) column of totals from the top total down to the bottom.  

2) The next column of totals from the top total down to the bottom.  

3) The other columns of totals, in turn, going from left to right. 

 

Then the cells with labels: 

4) The lower left corner cell that has the label "Total". 

5) The row labels (first column) starting at the bottom and going up. 

6) The upper right corner cell that has the label "Total". 

7) The column labels (top row) starting at the right and going left. 

 

Notes: 
The stealth Cross-Tab that you have hidden cannot be allowed to grow longer or wider than your 

page.  If it is wider than the page, you will get empty virtual pages to the right of the original 

page.  If the Cross-Tab is longer than the page, the underlay will not be able to hide all of it.  

(Underlay is limited to one page.)   If you are trying to hide a really large Cross-Tab, you can 

make the cells very tiny but you will still run into a limit.  Beyond this limit you may need to use 

a stealth subreport instead of a stealth Cross-Tab.  

 

This technique also works at the group level, which means that you can have a Cross-Tab in each 

Group Header.  Just remember to reset the variables between groups. 
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36. Reporting on data that isn't there: 

Crystal will not create a group unless there is at least one record for that group in the report.  

This is also true in Cross-Tabs and Charts.  However, it is not unusual for users to request that 

missing groups show up with a zero.  There are several ways to do this and the approach to use 

depends on a number of factors.  I will give a brief description of 6 different techniques below.   

 

Say that we need a report to list total sales for each salesman this month.  We want each 

salesman listed - even those with no sales in the month.  Here are your options: 

 

1) Manually enter one zero sales record for each salesman:  
This is not usually practical, but it is an easy short term solution.  It is most useful when reports 

are only going to be run once, and if there are a limited number of groups.  The Group Tree, 

Charts and Cross-Tabs will all incorporate these zero groups, automatically.  

 

2) Expand your selection criteria to include irrelevant records to create the groups: 

(36a Extra Records.rpt) 
This technique works if you have other records in the table that are not used by the report, but 

that exist for every group.  Take our example and assume that the sales table includes both sales 

records and call records.  We are told that every salesman has at least one call per month (even 

when he doesn’t have any sales).  So you can select BOTH calls and sales for the report.  This 

creates a group for every salesman in the report.  However, you only show the sales records, and 

you only use the sales records in the subtotals and calculations.  To do this, write a formula that 

says: 

 

if {Type} = "Sale" 

then {Amount} else 0 

  

When you subtotal this formula by salesman you will have a total of only the sales transactions.  

If you are printing the details you would suppress the “call” details and only show the “sales” 

details.  Again, Groups, Charts and Cross-Tabs will incorporate the zero groups, automatically.  
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3) Join a primary table that has all groups, and use an outer join: 

(36b Outer Join.rpt) 
If you have table that lists all of the salesmen, you can use this table as the reports primary table.  

Link this table to your transactions with a "Left Outer" join.  This tells the database that you 

want ALL records from the primary table and only matching records from the transaction table.  

If a salesman has NO transactions he will have only one record in the report.  All transaction 

fields would be NULL so Totals may show up as blanks instead of zeros.  You can fix this by 

using the Setting “Convert Null Field Values to Default” or by totaling a formula like this one: 

 

if IsNull ({Orders.Order Amount})  

then 0 else  

{Orders.Order Amount} 

 

However, there is a weakness to this approach.  You will not be able to put ANY criteria on the 

transaction fields.   IF you do, you cancel the effect of the outer join.  So in our example, when 

you select transactions for one month, you would then lose all salesmen who had no sales in that 

month.  To keep the outer join behavior, you have to eliminate ALL criteria from the 'Outer' 

table.  In our example this would mean including ALL transactions for ALL months.   You 

would have to suppress the details of the other months, and not include them in totals (like option 

2) but if your database is large, this makes for a very slow report.   On the plus side, Groups, 

Charts and Cross-Tabs will all pick up the zero groups.  
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53. Embedding a field into the “Total” text of a Cross-Tab: 

(53 Field in Cross-Tab Text Object.rpt) 
Every Cross-Tab has at least 2 cells that you can modify like a text object on the report. They 

both default to the word “Total”. You will usually find one in the upper right hand corner, and 

the other in the lower left. They are similar to text objects in two ways: 

 

1) You double click them to get into Edit mode and then you can enter any text you want. 

2) You can also embed fields into either of these text objects 

The difference is that with regular text objects you can simply drag a field over the object and 

embed the field in it. This doesn’t work when you are trying to embed a field into a Cross-Tab 

text cell. To embed into a Cross-Tab cell you must:  

1) Place the formula or field somewhere onto the report. 

2) Copy the object 

3) Double click the text cell to get it into edit mode. 

4) Put your cursor in the text at the appropriate point 

5) Paste the field into the object. 

 

You will see the field name appear within the text. Click outside of the cell to lock in the text 

object. When you preview, you will see the value of the field or formula in the text.  

 

Note – This field can be any database field or formula from the report, but it can not display a 

value derived from the Cross-Tab itself. 
 


